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2Input Image



3What will happen if I poke the piggy bank?



4Real video footage



Goal: turn image(s) into an interactive world
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Input image
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Output image/video
What if?
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Key Idea: Perceive, Simulate and Render
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Key Idea: Perceive, Simulate and Render
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A suitable representation that 

facilitates physics simulation

A good inductive bias in 

physics for our task



Poking an image

PhysGen: Rigid-Body Physics-Grounded Image-to-Video Generation Shaowei 
Liu, Zhongzheng Ren, Saurabh Gupta*, Shenlong Wang*, ECCV 2024

Shaowei Liu



SEINE I2VGEN-XL DynamiCrafter Kling AI

Latest open-sourced model Latest closed-source model

photorealistic animation of a piggy bank, placed on a smooth surface, being poked firmly by an unseen force 

from the right side, causing it to slide and rotate from right to left. As the piggy bank moves, it hits the pink ball, 

displacing the ball slightly before the ball rolls and falls off the surface onto the ground. The piggy bank 

continues sliding a little further and comes to a stop exactly where the ball was initially located. The motion 

should be smooth, with realistic physics, lighting, and shadows.

Generative Image2Video models…

*Sota i2v diffusion models by Aug 2024

Shaowei Liu



Perceive → Simulate → Render → Video

11PhysGen: Rigid-Body Physics-Grounded Image-to-Video Generation Shaowei 
Liu, Zhongzheng Ren, Saurabh Gupta*, Shenlong Wang*, ECCV 2024

Rendering & Refinement

t=0s t=.3s t=.5s t=.7s

Shaowei Liu



Qualitative results

SEINE I2VGEN-XL KlingAI Ours

PhysGen: Rigid-Body Physics-Grounded Image-to-Video Generation Shaowei 
Liu, Zhongzheng Ren, Saurabh Gupta*, Shenlong Wang*, ECCV 2024
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Controllability & Diversity

PhysGen: Rigid-Body Physics-Grounded Image-to-Video Generation Shaowei 
Liu, Zhongzheng Ren, Saurabh Gupta*, Shenlong Wang*, ECCV 2024

Generated samples

Real samples



Demo

https://stevenlsw.github.io/physgen/

PhysGen: Rigid-Body Physics-Grounded Image-to-Video Generation Shaowei 
Liu, Zhongzheng Ren, Saurabh Gupta*, Shenlong Wang*, ECCV 2024



Extend to 3D dynamics and multiphysics

Boyuan Chen, Hanxiao Jiang, Shaowei Liu, Saurabh Gupta, Yunzhu Li, Hao Zhao, Shenlong Wang, 

PhysGen3D: Crafting a Miniature Interactive World from a Single Image, CVPR 2025



Perceive → Simulate → Render

Boyuan Chen, Hanxiao Jiang, Shaowei Liu, Saurabh Gupta, Yunzhu Li, Hao Zhao, Shenlong Wang, 

PhysGen3D: Crafting a Miniature Interactive World from a Single Image, CVPR 2025

Shaowei LiuHanxiao JiangBoyuan Chen



Image → Perceive → Simulate → Render → Video

● Segmentation: SegAnything v2

● Scene Geometry: Dust3R

● Ground Plane: Neural vanishing points

● Textured Mesh: InstantMesh

● Background: SDXL

● Image-Mesh Align: SuperGlue + PnP

● Light: Diffusion Light

● PBR Material: Mitsuba3 InvRendering

● Physical understanding: GPT-4o



Comparisons: 3D rigid body rolling

Kling AI* Runway Gen-3 Pika 1.5 Ours

*SOTA video models by Nov 2024
* Kling AI uses privileged information 

from user-provided motion guidance.

"Red apple rolls on the table."



Comparisons: multiple objects

Kling AI Runway Gen-3 Pika 1.5 Ours

* Kling AI uses privileged information 

from user-provided motion guidance.
*SOTA video models by Nov 2024

"The book falls and the orange rolls to the front."



Comparisons: soft-body & scene interaction

Kling AI Runway Gen-3 Pika 1.5 Ours

*SOTA video models by Nov 2024
* Kling AI uses privileged information 

from user-provided motion guidance.

"The toy falls off the chair."



Comparisons: material editing

Kling AI Runway Gen-3 Pika 1.5 Ours

*SOTA video models by Nov 2024
* We use a specific-purpose model from Pika 

for such physical effects comparison.

The dog deflates and collapses.



Comparisons: Multi-Objects

Kling AI

”Three stuffed animal jump forward."

Pika 1.5 Ours

*SOTA video models by Nov 2024

Runway Gen-3

* Kling AI uses privileged information 

from user-provided motion guidance.



Video → Interactive Environment
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Novel View Rendering



Video → Interactive Environment
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Interactive Scene with Full Articulation



Overview of DRAWER
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Hongchi Xia

DRAWER: Digital Reconstruction and Articulation With Environment Realism Hongchi Xia, Entong Su, Marius Memmel, Arhan Jain, Raymond Yu, Numfor 
Mbiziwo-Tiapo, Ali Farhadi, Abhishek Gupta, Shenlong Wang, Wei-Chiu Ma International Conference on Computer Vision and Pattern Recognition (CVPR), 2025



Interactive Environment
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Application: Gaming

30



Application: Robot Learning via Real2Sim2Real
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What if we observe dynamic interaction?

32
PhysTwin: Physics-Informed Reconstruction and Simulation of Deformable Objects from Videos, 

Hanxiao Jiang, Hao-Yu Hsu, Kaifeng Zhang, Hsin-Ni Yu, Shenlong Wang, Yunzhu Li, arXiv 2025

Hanxiao Jiang



Hanxiao Jiang, Hao-Yu Hsu, Kaifeng Zhang, Hsin-Ni Yu, Shenlong Wang, Yunzhu Li

PhysTwin: Physics-Plausible Reconstruction and Resimulation from Videos
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Target state

MPC Policy
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Specialist interactive videos



Throw a basketball with fire towards vase with flowers
and break the vase with collision.

Throw a basketball with fire towards vase with flowers

and break the vase with collision.



Someone needs to do heavy lifting! 
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Throw a basketball with fire towards vase with flowers

and break the vase with collision.

PhD Comics



AutoVFX: Generalist Interactive Video
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Input Video VFX Modules

“Throw a basketball with fire
towards the vase”

LLM Code Generation

Input Instruction

Scene Modeling

(SfM, GSplats, Neural SDF, 

SAM, HDR light)

Holistic Scene Models

LightingAppearance

Geometry Semantics

def auto_vfx(video):

# scene modeling and understanding

scene = scene_modeling(video)

# generate object asset

ball = retrieve(”basketball”)

if ball is None:

ball = generate(”basketball”)

fireball = add_fire(ball)

# segment and localize existing objects from the scene 

vase = localize_object(scene, “vase”)

vase = enable_fracture(vase)

# animate new objects

traj = set_trajectory(fireball, vase)

animated_objs = set_animation(fireball, vase, traj)

# physical interaction with existing scene

output_scene = simulate(scene, animated_objs)

# render and composite

output_video = composite(video, render(output_scene))

return output_video

Physical Simulation

add_fire() fracture()

…

Animate

set_trajectory()

…

3D Asset Retrieval

retrieval()

…

Rendering & Composite

+ +

composite()

…

AutoVFX: Physically Realistic Video Editing from Natural Language Instructions, 3DV 2025

Hao-Yu Hsu



AutoVFX: Generalist Interactive Video
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AutoVFX: Generalist Interactive Video
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AutoVFX: Let the LLM agent code for us
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AutoVFX: Let the LLM agent code for us
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Drop 5 basketballs on the table.



Make the vase with flowers to be like a mirror.



Insert an animated Pikachu on the table.



Put a Tony Stark on the floor covered with smoke.



Drop four barrels onto the floor: one mirror-like, one with fabric textures,
one resembling pavement, and one unchanged.



Insert a physics-enabled Benz G 20 meters in front of us with random 2D rotation. Add 
a Ferrari moving forward.



Drop a Tesla cybertruck with fire randomly in front of our vehicles from 3 meters high.



Perceive, Simulate and Render
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Projects summary

● PhysGen (ECCV 2024): https://stevenlsw.github.io/physgen/

● Video2Game (CVPR 2024): https://video2game.github.io/

● ClimateNeRF (ICCV 2023):  https://climatenerf.github.io/

● AutoVFX (3DV 2025): https://haoyuhsu.github.io/autovfx-website/

● UrbanIR (3DV 2025): https://urbaninverserendering.github.io/

● PhysTwin (arXiv): https://jianghanxiao.github.io/phystwin-web/

● PhysGen3D (CVPR 2025, ExHall D Poster #71 4pm-6pm Fri Jun 13): 

https://by-luckk.github.io/PhysGen3D/

● DRAWER (CVPR 2025, ExHall D Poster #68, 10:30-12:30 Sun 15 Jun): 

https://xiahongchi.github.io/DRAWER/

● IRIS (CVPR 2025, ExHall D Poster #28 Fri 13 Jun 10:30am-12:30pm): 

https://irisldr.github.io

All our projects have open-sourced code.

https://stevenlsw.github.io/physgen/
https://video2game.github.io/
https://climatenerf.github.io/
https://haoyuhsu.github.io/autovfx-website/
https://haoyuhsu.github.io/autovfx-website/
https://haoyuhsu.github.io/autovfx-website/
https://urbaninverserendering.github.io/
https://jianghanxiao.github.io/phystwin-web/
https://jianghanxiao.github.io/phystwin-web/
https://jianghanxiao.github.io/phystwin-web/
https://by-luckk.github.io/PhysGen3D/
https://by-luckk.github.io/PhysGen3D/
https://by-luckk.github.io/PhysGen3D/
https://xiahongchi.github.io/DRAWER/
https://irisldr.github.io/


Lemon-picking



Lemon-picking



The Two Cultures

56

“World Models” 
Data-driven, Generation, Implicit

“Digital Twins”
Model-based, Simulation, Explicit

Sora Blender



AutoVFXPika 1.5 Effects

Melt the vase with flowers into liquid.

The Two Cultures



AutoVFXPika 1.5

Drop 5 basketballs on the table.

The Two Cultures
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Controllable Weather Synthesis and Removal with Video Diffusion Models, Chih-Hao Lin, Zian Wang, Ruofan Liang, Yuxuan 

Zhang, Sanja Fidler, Shenlong Wang, Zan Gojcic, arXiv 2025
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Zhang, Sanja Fidler, Shenlong Wang, Zan Gojcic, arXiv 2025



Input Video Weather Removal

WEATHER REMOVAL MODEL transform input video into clear-day output, effectively 
remove both transient (raindrop, snowflake) and persistent (puddles) effects



Input Video Weather Removal

WEATHER REMOVAL MODEL transform input video into clear-day output, effectively 
remove both transient (raindrop, snowflake) and persistent (puddles) effects
Controllable Weather Synthesis and Removal with Video Diffusion Models, Chih-Hao Lin, Zian Wang, Ruofan Liang, Yuxuan 

Zhang, Sanja Fidler, Shenlong Wang, Zan Gojcic, arXiv 2025



Input Video

WeatherWeaver (generative model) ClimateNeRF (physical sim)

WeatherWeaver (arXiv): https://research.nvidia.com/labs/toronto-ai/WeatherWeaver/

ClimateNeRF (ICCV23): https://climatenerf.github.io/

The Bitter Lessons?

Chih-Hao Lin

https://research.nvidia.com/labs/toronto-ai/WeatherWeaver/
https://research.nvidia.com/labs/toronto-ai/WeatherWeaver/
https://research.nvidia.com/labs/toronto-ai/WeatherWeaver/
https://research.nvidia.com/labs/toronto-ai/WeatherWeaver/
https://research.nvidia.com/labs/toronto-ai/WeatherWeaver/
https://climatenerf.github.io/
https://climatenerf.github.io/
https://climatenerf.github.io/
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Open Questions

● Synergizing modeling and interaction: Model the physical world to enable 

physical interaction → interact with the physical world to better model the world.

● Need for perfection: Physical simulation expects nearly error-free scene 

understanding – what can we do when we haven’t yet solved computer vision?

● The two cultures: How to better harness the best of model-based simulation and 

data-driven generation. 



Open Questions

● Need for perfection: Physical simulation expects nearly error-free scene 

understanding – what can we do when we haven’t yet solved computer vision?

● The two cultures: How to better harness the best of model-based simulation and 

data-driven generation. 

● Physical understanding for physical AI: Model the physical world to enable 

interaction → interact with the physical world to better model the world.

● Broaden impact beyond content creation, gaming, and robotics.



What is a good inductive bias for content creation?

Universal Laws 
Newtonian physics, Conservation laws

Statistical Priors
Laplacian smooth, As-rigid-as-possible Reg, 

Bilateral smooth

Hard Constraints
Collision-free constraint, Kinematic Chain, Watertightness

Soft Regularizers
Penetration loss

Easy to impose, costly to learn
Rigid-body dynamics

Hard to impose
Hair dynamics, Physical-based lighting

Essential for Downstream
Grounded physics for robotic-manipulation simulators

Optional for Downstream
Grounded physics for creating TikTok videos

*in the scaling-law era
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Perceive, Simulate and Render
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